
МЕТОДИЧНІ ВКАЗІВКИ ДО ВИКОНАННЯ ПРАКТИЧНОЇ РОБОТИ 

Практична робота № 1 

Огляд інтерфейсу користувача АrcGIS 

Мета: Ознайомитись з основними елементами інтерфейсу користувача програми ArcGIS 

та вивчити основи роботи з геоінформаційною системою. 

Завдання: 

1. Ознайомитися з інтерфейсом програми ArcGIS. 

2. Навчитися використовувати основні інструменти для створення, редагування та 

візуалізації просторових даних. 

Теоретичні положення: ArcGIS — це одна з найбільш поширених платформ для роботи з 

геоінформаційними системами, що дозволяє виконувати просторовий аналіз, візуалізацію 

та управління просторовими даними. Інтерфейс програми поділений на кілька основних 

панелей, таких як панель інструментів, панель легенди, панель стану та карти, що 

дозволяє зручно організувати робочий процес. Знання інтерфейсу є основою для 

ефективного використання ArcGIS у різних сферах, від картографії до геологічних 

досліджень. 

Порядок виконання: 

1. Запуск програми ArcGIS: 

o Відкрийте програму ArcGIS. Зазвичай програма має головне вікно, яке 

поділено на кілька областей: меню, панелі інструментів, карта (основне 

вікно для роботи з даними), а також вкладки для налаштувань проекту. 

o Переконайтесь, що інтерфейс відображає всі необхідні панелі: "Catalog", 

"Table of Contents", "Tools", "Editor", тощо. 

2. Огляд основних елементів інтерфейсу: 

o Меню: Основне меню містить такі пункти, як "File", "View", "Insert", 

"Tools", "Window", що дають доступ до основних функцій програми. 

o Панель інструментів: Розташована в верхній частині вікна програми і 

містить основні кнопки для роботи з проектами, наприклад, для збереження, 

відкриття файлів, додавання нових шарів, а також інструменти для роботи з 

картами. 

o Панель інструментів "Table of Contents": Це панель, на якій 

відображаються всі шари карт, дані та атрибути, що використовуються в 

поточному проекті. 

o Панель карт: Центральна область, де відображається карта. Тут ви будете 

працювати з просторовими даними, переміщувати карту, змінювати 

масштаб та переглядати візуалізацію даних. 

o Панель "Catalog": Використовується для навігації та доступу до файлів та 

даних, що зберігаються на комп'ютері або в мережі. Тут можна знаходити 

різні типи файлів, що використовуються в ArcGIS, такі як шари даних, 

геодані, картографічні проекти тощо. 

3. Додавання нового шару даних: 

o Для початку роботи з картою потрібно додати дані, які ви хочете 

використовувати в аналізі. Перейдіть до панелі "Catalog", знайдіть файл, що 

містить потрібні дані, і перетягніть його на карту. 



o Зазначте, що дані повинні бути у форматі, сумісному з ArcGIS (наприклад, 

Shapefile, GeoTIFF, KML). 

4. Навігація по карті: 

o Для навігації по карті використовуйте панель інструментів, де є кнопки для 

збільшення, зменшення масштабу, переміщення по карті (панель "Zoom" і 

"Pan"). 

o Ознайомтесь з можливостями перегляду карти, зокрема, можливість 

перемикатися між різними шарами, налаштовувати їх видимість та стиль 

відображення. 

5. Редагування даних: 

o У програмі ArcGIS є можливість редагувати дані, використовуючи 

інструмент "Editor". Для цього необхідно вибрати шар, з яким ви хочете 

працювати, активувати режим редагування та внести необхідні зміни 

(додавання точок, ліній або полигонів, редагування атрибутів). 

6. Візуалізація та стилізація даних: 

o Розгляньте, як можна змінювати стиль відображення даних на карті. Для 

цього натискайте правою кнопкою миші на шарі та вибирайте "Properties", 

де можна змінювати кольори, типи ліній, прозорість та інші параметри 

візуалізації. 

7. Експорт та збереження карти: 

o Після завершення роботи з картою можна експортувати її у різні формати 

(наприклад, PNG, JPEG, PDF) для подальшого використання або друку. 

o Для цього виберіть пункт "File" -> "Export Map", де можна налаштувати 

формат і якість вихідного файлу. 

Оформлення результатів роботи: 

1. Під час виконання практичної роботи зробіть скріншоти інтерфейсу програми, які 

відображають важливі етапи роботи. 

2. Завершену карту збережіть у форматі, який підходить для подальшого 

використання або друку. 

3. Оформіть звіт з виконання практичної роботи, де зазначте всі виконані кроки, 

зроблені налаштування та отримані результати. 

Примітка: Не забувайте, що для ефективної роботи з ArcGIS важливо постійно 

практикуватися та вивчати додаткові інструменти для роботи з просторовими даними, 

щоб досягти максимальної точності та ефективності при аналізі геоінформації. 

 

Практична робота № 2 

Обробка растрового зображення в ArcGIS 

Мета: Ознайомитись з основними методами обробки растрових зображень в ArcGIS, 

навчитися виконувати базові операції з растровими даними, такими як корекція, аналіз і 

візуалізація. 

Завдання: 

1. Ознайомитися з процесом завантаження растрових зображень в ArcGIS. 

2. Вивчити основні інструменти обробки растрових зображень, зокрема корекцію 

зображень, виконання просторових операцій та аналізу. 



3. Навчитися виконувати візуалізацію оброблених даних на карті. 

Теоретичні положення: Растрові зображення в ГІС є одними з найбільш поширених 

типів даних, які використовуються для представлення різноманітних географічних і 

просторових явищ, таких як знімки супутників, аерофотозйомки, температурні карти 

тощо. Кожен піксель в растровому зображенні містить значення певного параметра 

(наприклад, висоти, температури, концентрації елементу), яке може бути використане для 

подальшого просторового аналізу. Обробка растрових зображень включає такі операції, як 

корекція кольору, змінення роздільної здатності, обчислення різних показників, виділення 

зон тощо. 

Порядок виконання: 

1. Завантаження растрових зображень: 

o Для початку відкрийте ArcGIS і створіть новий проект. 

o Завантажте растрове зображення в програму через меню "Catalog". Для 

цього знайдіть необхідний файл з растровим зображенням (наприклад, 

зображення з супутникових знімків або аерофото) і перетягніть його на 

карту. 

o Переконайтесь, що зображення коректно завантажене, та перевірте його 

проекцію і географічні координати. 

2. Визначення властивостей растрового зображення: 

o Клацніть правою кнопкою миші на зображенні в панелі "Table of Contents" і 

виберіть "Properties". 

o У вікні "Properties" перегляньте інформацію про растрове зображення, таку 

як роздільна здатність (розмір пікселів), проекція, мінімальні та максимальні 

значення пікселів. 

o Переконайтесь, що зображення відповідає вашому проєкту і має правильні 

географічні координати. 

3. Обробка растрового зображення: 

o Використовуйте інструмент "Raster Calculator" для виконання базових 

операцій з растровими зображеннями. Наприклад, ви можете виконати 

математичні операції між кількома растровими шарами (скласти, відняти 

або перемножити зображення). 

o Для цього перейдіть до меню "Spatial Analyst" -> "Map Algebra" -> "Raster 

Calculator", виберіть необхідні растрові шари і введіть математичну 

формулу для їх обробки. 

4. Корекція растрового зображення: 

o Якщо зображення потребує корекції (наприклад, корекція кольору чи 

яскравості), використовуйте інструменти зменшення контрасту або корекції 

кольору. Це можна зробити через меню "Raster" -> "Spatial Analyst" -> 

"Reclassify" або інші інструменти для корекції зображень. 

o Виберіть відповідний метод корекції, залежно від типу зображення і 

завдань. 

5. Виконання просторових операцій: 

o Ви можете застосовувати різні просторові операції для аналізу растрових 

зображень, наприклад, операції зонування (перетворення зображень у певні 

зони на основі значень пікселів), обчислення різниць між зображеннями та 

інше. 

o Для виконання операцій перейдіть до "Spatial Analyst" -> "Reclassify", "Map 

Algebra" або інших інструментів для виконання просторових операцій. 

6. Візуалізація результатів: 



o Після обробки растрового зображення ви можете змінити його стилізацію 

для кращої візуалізації. Використовуйте функцію зміни кольору через 

"Symbology" в меню властивостей шару. 

o Виберіть тип візуалізації (наприклад, градація кольору для зображень 

температури або висоти), налаштуйте кольорову палітру і відобразіть 

результати на карті. 

7. Аналіз результатів: 

o Після обробки растрового зображення проведіть аналіз отриманих 

результатів. Зробіть висновки про те, як обробка змінює візуалізацію та які 

зміни відбулись у даних після виконання операцій. 

8. Експорт обробленого зображення: 

o Завершивши обробку та аналіз, збережіть результат. Для цього перейдіть до 

меню "File" -> "Export Map" або "Export Raster", виберіть формат файлу 

(наприклад, TIFF, JPEG) і збережіть зображення. 

Оформлення результатів роботи: 

1. Збережіть результати обробки в окремий файл, щоб мати можливість поділитися 

або представити їх. 

2. Оформіть звіт, включаючи скріншоти інтерфейсу, опис виконаних операцій та 

отриманих результатів. 

3. Визначте, яку роль відіграє оброблене зображення в контексті вашого дослідження 

або проекту. 

Примітка: Для більш ефективної обробки растрових зображень рекомендується 

ознайомитись з додатковими можливостями програмних інструментів ArcGIS, що 

дозволяють застосовувати складніші аналізи та візуалізації. 

 

Практична робота № 3 

Трасування штатними та зовнішніми програмами растрового зображення в ArcGIS 

Мета: Ознайомитись з методами трасування растрових зображень в ArcGIS за допомогою 

стандартних інструментів програмного забезпечення та зовнішніх програм. Навчитися 

виконувати трасування для аналізу геопросторових даних. 

Завдання: 

1. Ознайомитися з методами трасування растрових зображень в ArcGIS. 

2. Виконати трасування з використанням штатних інструментів ArcGIS. 

3. Виконати трасування за допомогою зовнішніх програм, таких як FME або іншого 

програмного забезпечення. 

4. Провести аналіз результатів трасування. 

Теоретичні положення: Трасування — це процес визначення геометричних ліній або 

контурів, що з’єднують пікселі растрового зображення з однаковими або схожими 

значеннями (наприклад, висоти, температури, концентрації елементів). Цей процес є 

важливим для виділення певних зон або елементів в межах великої території, що 

зображена на растровому зображенні. Трасування може застосовуватись для виділення 

кордонів, визначення важливих ліній або для подальшого геопросторового аналізу. 



Порядок виконання: 

1. Завантаження растрового зображення: 

o Відкрийте ArcGIS і створіть новий проект. 

o Завантажте растрове зображення за допомогою меню "Catalog". Для цього 

знайдіть відповідне растрове зображення, яке ви будете використовувати 

для трасування (наприклад, супутникове зображення чи аерофото), і 

перетягніть його на карту. 

o Переконайтесь, що зображення має правильну проекцію та координати. 

2. Трасування з використанням стандартних інструментів ArcGIS: 

o Для початку скористайтесь інструментом "Raster to Polygon", щоб 

перетворити растрові дані в векторний формат, зберігши контури. Це 

дозволить працювати з окремими зонами та об’єктами. 

o Для цього відкрийте меню "Conversion Tools" -> "From Raster" -> "Raster to 

Polygon". Виберіть растрове зображення та налаштуйте параметри для 

конвертації. 

o Після перетворення растрового зображення в полигональний формат, можна 

буде виконати трасування ліній, що з’єднують однакові значення в межах 

зображення. 

3. Трасування контурів з використанням "Contour" в ArcGIS: 

o Використовуйте інструмент "Contour" для трасування контурів на основі 

значень пікселів растрового зображення. 

o Перейдіть до меню "Spatial Analyst" -> "Surface" -> "Contour" і налаштуйте 

параметри для генерації контурів. Вкажіть інтервал між контурами та інші 

необхідні параметри. 

o Результатом буде набір ліній, що з’єднують пікселі з однаковими 

значеннями, наприклад, для висот або інших параметрів. 

4. Виконання трасування з використанням зовнішніх програм (наприклад, 

FME): 

o Для більш складних трасувальних задач можна використовувати зовнішні 

програми, такі як FME (Feature Manipulation Engine), що надають додаткові 

інструменти для роботи з геопросторовими даними. 

o Завантажте відповідне растрове зображення у FME та використовуйте 

інструменти трасування, щоб виділити необхідні контури або лінії на основі 

значень пікселів. 

o Програма FME дозволяє створювати більш точні та складні моделі 

трасування, включаючи інтеграцію з іншими даними і форматами. 

5. Аналіз результатів трасування: 

o Після виконання трасування оцініть отримані контури та лінії. Перевірте, чи 

коректно відображаються контури на зображенні та чи правильно вони 

відповідають параметрам вашого дослідження. 

o Проведіть аналіз отриманих результатів, визначивши, чи зберігається 

необхідна точність та деталі при трасуванні контурів, а також чи правильно 

відображені географічні особливості. 

6. Візуалізація результатів трасування: 

o Після виконання трасування результат можна візуалізувати на карті. 

Налаштуйте стиль візуалізації для ліній, щоб чітко відобразити контури або 

траси на карті. 

o Використовуйте відповідні кольори та товщину ліній для візуалізації 

результатів трасування. 

7. Експорт результатів: 



o Після завершення обробки трасування збережіть результати роботи у 

відповідному форматі, щоб мати змогу використовувати їх для подальших 

аналізів або для представлення результатів. 

o Для цього перейдіть до "File" -> "Export" і виберіть потрібний формат для 

збереження даних. 

Оформлення результатів роботи: 

1. Створіть звіт, що містить скріншоти інтерфейсу програми, опис виконаних 

операцій та отриманих результатів. 

2. Включіть аналіз результатів трасування та пояснення щодо вибору інструментів 

для обробки даних. 

3. Визначте можливі варіанти застосування трасування для подальших досліджень та 

проектів. 

Примітка: Для більш точного трасування рекомендується ознайомитись з додатковими 

інструментами та програмами, що можуть бути корисними для обробки різноманітних 

растрових зображень і геопросторових даних. 

 

Практична робота № 4 

Візуалізація та експорт отриманих даних в ArcGIS 

Мета: Ознайомитись з методами візуалізації та експортом геопросторових даних в 

ArcGIS. Навчитися налаштовувати стилі візуалізації даних та експортувати результати 

роботи в різні формати для подальшого використання або друку. 

Завдання: 

1. Ознайомитись з основними методами візуалізації даних в ArcGIS. 

2. Налаштувати стилі візуалізації для різних типів даних (точки, лінії, полігони). 

3. Виконати експорт карт та результатів аналізів у різні формати для подальшого 

використання. 

Теоретичні положення: Візуалізація в географічних інформаційних системах (ГІС) — це 

процес представлення просторових даних у вигляді карт або інших графічних об’єктів, що 

дозволяє зрозуміти просторові взаємозв’язки та аналізувати різноманітні аспекти 

географічної інформації. Візуалізація даних в ArcGIS включає налаштування стилів для 

різних типів даних, таких як точки, лінії та полігони, а також використання різних 

кольорів, розмірів і символів для вираження інформації. 

Експорт даних дозволяє зберігати результати роботи в різних форматах для подальшої 

обробки, публікації чи друку. В ArcGIS можна експортувати карти, шари, таблиці та інші 

геопросторові дані в такі формати, як PDF, JPEG, TIFF, SHP, а також в інші формати, які 

підтримуються іншими програмами та системами. 

Порядок виконання: 

1. Налаштування стилів візуалізації: 

o Відкрийте ArcGIS і завантажте дані, які ви хочете візуалізувати (це можуть 

бути точки, лінії або полігони, залежно від вашого завдання). 



o Для налаштування стилю правою кнопкою миші клікніть на шар даних в 

панелі "Table of Contents" і виберіть "Properties". 

o У вікні "Layer Properties" перейдіть на вкладку "Symbology". Тут ви можете 

вибрати тип візуалізації для вашого шару: 

▪ Для точок: оберіть "Categories" та налаштуйте кольори для різних 

категорій. 

▪ Для ліній: оберіть "Quantities" або "Unique Values" для візуалізації за 

значеннями або категоріями. 

▪ Для полігонів: використовуйте "Graduated Colors" для візуалізації за 

кількісними значеннями або "Unique Values" для категоріальних 

даних. 

o Настройте кольори, розміри, форму символів та інші параметри, щоб чітко 

відобразити важливі аспекти ваших даних. 

2. Візуалізація результатів аналізу: 

o Після того, як ви налаштували стиль для основних даних, приступайте до 

візуалізації результатів аналізу. Це може бути результат просторового 

аналізу, створення буферів, трасування або інших типів аналізу. 

o Використовуйте інструменти візуалізації ArcGIS для підсвічування 

важливих елементів, наприклад, за допомогою різних кольорів або розмірів 

для виділення результатів геопросторових операцій. 

o Також можна використовувати інструмент "Layer Transparency", щоб 

зробити певні шари напівпрозорими для кращого перегляду під ними інших 

даних. 

3. Налаштування карти для друку: 

o Коли карта готова, підготуйте її до друку. Перейдіть на вкладку "Layout 

View" для створення макету карти. 

o Налаштуйте розмір аркуша, поля, заголовки та легенди. Можна додавати 

інші елементи, такі як масштаб, північний напрямок, підписи. 

o Для налаштування вигляду карти виберіть "Insert" -> "Legend", "North 

Arrow" або інші елементи, які ви хочете включити. 

4. Експорт результатів в інші формати: 

o Після того, як ви налаштували візуалізацію карти, можна експортувати її в 

різні формати. 

o Для експорту карти перейдіть до "File" -> "Export Map". 

o Виберіть потрібний формат для збереження: 

▪ PDF: для друку або подальшого поширення. 

▪ JPEG, TIFF, PNG: для збереження карти у вигляді зображення. 

▪ Shapefile (SHP): для експорту даних, щоб їх можна було 

використовувати в інших ГІС-системах. 

▪ KML: для експорту даних у формат, який можна переглядати в 

Google Earth. 

o Налаштуйте параметри експорту, такі як роздільна здатність (для 

зображень) та інші параметри, які можуть вплинути на якість результату. 

5. Збереження результатів в геопросторовому форматі: 

o Для збереження змін, що були внесені в шари даних (наприклад, після 

аналізу або трасування), використовуйте інструмент "Save As Layer File". Це 

дозволить зберегти всі налаштування і стратегії візуалізації для подальшої 

роботи. 

o Також можна створити нові шари, якщо ви додали нові елементи в існуючі 

дані або після виконання операцій, таких як буферизація або створення меж. 

6. Документування та підготовка звіту: 



o Після виконання візуалізації та експорту результатів оформіть звіт, який 

включатиме: 

▪ Скриншоти карти до і після налаштування візуалізації. 

▪ Опис налаштувань стилів і візуалізації. 

▪ Аналіз результатів та їх застосування для подальших досліджень або 

проектів. 

Примітка: 

Експорт карт та даних дозволяє інтегрувати результати роботи в інші програмні продукти 

або публікувати їх у вигляді карт для веб-ресурсів чи звітів. Використовуйте правильні 

формати для конкретних завдань, щоб забезпечити найкращу якість результатів. 

Практична робота № 5 

Імпорт даних та контроль їх якості 

Мета: Ознайомитись з процесом імпорту даних з різних джерел у програмне забезпечення 

для геофізичних та геологічних досліджень, а також навчитися здійснювати контроль 

якості імпортованих даних. 

Завдання: 

1. Імпортувати дані з різних джерел у програмне забезпечення. 

2. Провести контроль якості імпортованих даних, виявити і виправити можливі 

помилки. 

3. Підготувати дані для подальшої обробки та аналізу. 

Теоретичні положення: Імпорт даних у геоінформаційні системи (ГІС) та інші 

спеціалізовані програми є важливим етапом для подальшого їх аналізу та візуалізації. 

Правильний імпорт забезпечує коректне використання даних у проекті, знижуючи 

ймовірність помилок при їх подальшій обробці. 

Існують різні типи даних, які можуть бути імпортовані в програми, включаючи: 

• Растрові дані (зображення, карти, фотографії). 

• Векторні дані (точки, лінії, полигони). 

• Табличні дані (відомості, зібрані з польових досліджень, лабораторних аналізів). 

Важливим аспектом є контроль якості імпортованих даних, який передбачає перевірку 

правильності формату, точності та повноти даних. 

Порядок виконання: 

1. Підготовка джерела даних: 

o Ознайомтесь із джерелом даних, що буде імпортовано (наприклад, таблиці з 

польових спостережень, дані каротажу або GPS-координати). 

o Перевірте формат даних (наприклад, .csv, .shp, .tif, .txt, .xyz). 

2. Імпорт даних у програмне забезпечення: 

o Відкрийте програму, в яку ви будете імпортувати дані (наприклад, ArcGIS, 

Petrel, Excel, або інші спеціалізовані програми). 



o Оберіть відповідну команду для імпорту даних (наприклад, в ArcGIS це 

може бути команда "Add Data" або "Import"). 

o Завантажте файл з даними, вказавши точний шлях до файлу або вибравши 

його через діалогове вікно. 

3. Перевірка якості імпортованих даних: 

o Контроль формату: Перевірте, чи правильно розпізнано формат даних. 

Наприклад, для векторних даних повинна коректно визначитись геометрія 

(точки, лінії, полігони), а для растрових — пікселі та їх відображення. 

o Перевірка коректності даних: Оцініть, чи всі дані коректно імпортувались, 

чи немає пропущених або пошкоджених значень (наприклад, якщо 

імпортується таблиця, переконайтесь, що всі поля містять коректні 

значення). 

o Перевірка точності географічних координат: Якщо ви працюєте з 

географічними даними (наприклад, GPS-координати), перевірте їх 

відповідність реальним об'єктам або місцевості на карті. 

o Контроль одиниць виміру: Перевірте, чи всі одиниці виміру (глибина, 

температура, щільність тощо) правильно імпортовані та не порушена їх 

логіка (наприклад, міліметри замість метрів). 

4. Обробка помилок імпорту: 

o Якщо виявлено помилки, використовуйте інструменти для виправлення або 

коригування даних: 

▪ Для табличних даних можна виправити значення вручну або через 

автоматичне коригування в програмі. 

▪ Для векторних і растрових даних можна застосувати методи для 

виправлення геометрії або перетворення координат. 

o За необхідності зверніться до джерела даних і переконайтесь, що вони не 

містять помилок ще на етапі збору. 

5. Перевірка на повноту даних: 

o Після імпорту перевірте, чи всі необхідні дані були включені. Якщо якихось 

даних не вистачає, зверніться до джерела інформації або здійсніть 

додатковий імпорт. 

o Підтвердження наявності всіх необхідних записів важливо для коректного 

аналізу даних. 

6. Експорт даних: 

o Після того як дані будуть успішно імпортовані та перевірені на коректність, 

збережіть їх у потрібному форматі для подальшої обробки або аналізу. 

o Використовуйте команду експорт даних, щоб зберегти їх у форматі, який 

буде зручний для подальшої роботи (наприклад, .csv, .xls, .shp). 

7. Документування результатів: 



o Зафіксуйте усі кроки імпорту даних у звіті, включаючи джерело даних, 

формат, тип імпорту, а також виявлені помилки і способи їх виправлення. 

o Оформіть звіт, зазначивши, чи вдалося успішно імпортувати і перевірити 

дані. 

Примітка: 

Імпорт даних і контроль їх якості є критично важливими етапами у роботі з географічною 

інформацією, оскільки від коректності цих процесів залежить точність подальших 

досліджень і прийнятих рішень. 

 

 

 

 

ВАЖЛИВО! 

При відсутності доступу до ліцензійного програмного забезпечення треба використовувати 

перегляд відео контенту (туторіалів) що надаються викладачем. Відеоконтент було записано на 

ліцензійному програмному забезпеченні з використанням усіх ліцензійних вимог. 

Посилання на відеоконтент надаються студентам викладачем у чаті або листі при листуванні. 

Запитати посилання можна за номером телефону +380632434380 



Приклади питань для підсумкового контролю  

40 залікових балів 

1. ОФОРМЛЕННЯ. На листочку формату А4 написати прізвище, група, курс, варіант, самі 
питання та відповіді на них.  
ЯК ОБРАТИ ВАРІАНТ. Обираєте 4 питання відповідно до букв свого прізвища. Питання 
пронумеровані за алфавітом. НАПРИКЛАД. Я Самчук = питання С, А, М, Ч. Якщо буква 
повторюється, берете наступну. 
КРИТЕРІЇ ОЦІНЮВАННЯ. Відповідь на кожне питання оцінюється від 0 до 10 балів. У сумі 
ви можите набрати 40 балів. 
 
 
КОНТРОЛЬНІ ЗАПИТАННЯ: 
А. ЯК ВІДОБРАЖАЮТЬСЯ ОБ’ЄКТИ РЕАЛЬНОГО СВІТУ В ГІС 
Б. СТРУКТУРИ ДАНИХ 
В. МОДЕЛІ ДАНИХ 
Г. ФОРМАТИ ДАНИХ 
Д. БАЗИ ДАНИХ І УПРАВЛІННЯ НИМИ 
Є. СПОСОБИ ВВЕДЕННЯ ДАНИХ 
Е. ПЕРЕТВОРЕННЯ ПОЧАТКОВИХ ДАНИХ 
Ж. ВВЕДЕННЯ ДАНИХ ДИСТАНЦІЙНОГО ЗОНДУВАННЯ 
З. ЗАВДАННЯ ПРОСТОРОВОГО АНАЛІЗУ 
И. ОСНОВНІ ФУНКЦІЇ ПРОСТОРОВОГО АНАЛІЗУ ДАНИХ 
І. АНАЛІЗ ПРОСТОРОВОГО РОЗПОДІЛУ ОБ’ЄКТІВ 
Ї. ПОВЕРХНЯ І ЦИФРОВА МОДЕЛЬ 
Й. ДЖЕРЕЛА ДАНИХ ДЛЯ ФОРМУВАННЯ ЦИФРОВОЇ МОДЕЛІ ПОВЕРХОНЬ (ЦМП) 
К. ІНТЕРПОЛЯЦІЯ 
Л. ТЕХНОЛОГІЯ ПОБУДОВИ ЦМП 
М. ЕЛЕКТРОННІ КАРТИ І АТЛАСИ 
Н. КАРТОГРАФІЧНІ СПОСОБИ ВІДОБРАЖЕННЯ РЕЗУЛЬТАТІВ АНАЛІЗУ ДАНИХ 
О. ТРИВИМІРНА ВІЗУАЛІЗАЦІЯ 
П. Етапи і правила проектування ГІС 
Р. Види ГІС 
С. Компіляція даних 
Т. Транзакційна система 
У. Реплікація з непрямим (нежорстким) зв’язком 
Ф. ГІС мережі 
Х. Каталоги ГІС-порталів 
Ц. Склад сучасної платформи ГІС 
Ч. Огляд ГІС , використовуваних в Україні 
Ш. ІНФОРМАТИКА І ГЕОІНФОРМАТИКА (визначення) 
Щ. ВИЗНАЧЕННЯ ГІС. ВІДМІННІСТЬ ГІС ВІД ІНШИХ ІНФОРМАЦІЙНИХ СИСТЕМ 
Ю. ІСТОРІЯ РОЗВИТКУ ГЕОІНФОРМАЦІЙНИХ ТЕХНОЛОГІЙ 
Я. ФУНКЦІЇ Й ГАЛУЗІ ЗАСТОСУВАННЯ ГІС І ГЕОІНФОРМАЦІЙНИХ ТЕХНОЛОГІЙ 

Зав. кафедри _________________________ Викладач_____________________ 

 



Розгорнутий план лекцій до дисципліни Інформаційні технології в геології 

Лекція 1. Геоінформаційні технології в сучасному світі 

Геоінформаційні технології (ГІТ) відіграють важливу роль у сучасних наукових 

дослідженнях та практичному застосуванні в геології. Вони дозволяють ефективно 

обробляти, аналізувати та візуалізувати просторові дані, що використовується при 

створенні карт, оцінці природних ресурсів і прогнозуванні геологічних процесів. В цій 

темі розглядається історія розвитку ГІТ, їх сучасні можливості та сфери застосування. 

Лекція 2. Структури і моделі даних 

Ефективна робота з геопросторовими даними потребує розуміння їх структури та моделей 

представлення. Розглядаються векторні та растрові моделі даних, їх переваги та недоліки, 

а також підходи до їх використання в геологічних дослідженнях. Особливу увагу 

приділено базам геоданих, топологічним відношенням та організації просторової 

інформації. 

Технологія введення даних 

Якість геоінформаційного аналізу залежить від точності та правильності введених даних. 

У цій темі розглядаються методи збору, обробки та введення просторових даних, 

включаючи використання супутникових знімків, аерофотознімання, GPS-технологій та 

цифрових картографічних матеріалів. Окрема увага приділяється проблемам похибок при 

введенні даних та їх корекції. 

Лекція 3. Аналіз просторових даних 

Просторовий аналіз дозволяє отримати нову інформацію про геологічні процеси та 

структури. Вивчаються основні методи аналізу, такі як накладання шарів, буферний 

аналіз, інтерполяція та кластеризація. Особлива увага приділяється аналізу геологічних 

ризиків, прогнозуванню змін природного середовища та виявленню закономірностей у 

розподілі корисних копалин. 

Лекція 4. Моделювання поверхонь 

Моделювання рельєфу та геологічних структур є важливим етапом геоінформаційного 

аналізу. Розглядаються методи створення цифрових моделей рельєфу (ЦМР) і поверхонь, 

такі як інтерполяція, триангуляція та метод об'єднаних висотних точок. Вивчаються 

підходи до створення 3D-моделей геологічних об’єктів та їх застосування у прогнозуванні 

і дослідженні геологічних процесів. 

Лекція 5. Візуалізація та експорт отриманих даних  

Отримані геопросторові дані потребують якісного представлення для подальшого 

використання. В цій темі розглядаються методи візуалізації геоданих, такі як тематичне 

картографування, побудова 3D-моделей та інтерактивні геопортали. Також аналізуються 

способи експорту даних у різні формати та інтеграція ГІС-даних з іншими 

інформаційними системами. 

Методи і засоби візуалізації 

Візуалізація просторової інформації відіграє важливу роль у розумінні геологічних 

процесів. Розглядаються основні методи картографічного представлення, використання 

кольорових схем, генерація діаграм та графіків. Особлива увага приділяється 3D-

візуалізації геологічних даних та інтерактивним технологіям візуалізації. 

Лекція 6. Концепція і вимоги ГІС 

Геоінформаційні системи (ГІС) мають чітко визначену архітектуру та принципи роботи. В 



цій темі аналізуються концептуальні основи ГІС, їх основні складові та функціональні 

можливості. Розглядаються вимоги до апаратного та програмного забезпечення, а також 

особливості організації ГІС-проєктів у геології. 

Лекція 7. Управління інформацією в ГІС 

Ефективне використання ГІС потребує грамотного управління великими обсягами 

геоданих. Вивчаються методи організації баз даних, системи управління геопросторовою 

інформацією (ГІС-БД) та принципи метаданих. Також розглядаються питання безпеки 

даних, резервного копіювання та інтеграції ГІС з іншими інформаційними системами. 

ГІС – розподілена інформаційна система 

Сучасні ГІС розвиваються в напрямку розподілених інформаційних систем, що дозволяє 

працювати з даними в режимі реального часу. В цій темі аналізуються принципи хмарних 

ГІС, веб-картографії та геоінформаційних сервісів. Розглядаються особливості організації 

віддаленого доступу до геоданих, використання веб-ГІС-платформ та інтеграції з 

глобальними інформаційними мережами. 

Лекція 8. Сучасні платформи ГІС 

На сучасному ринку існує багато програмних платформ для роботи з ГІС. Вивчаються 

найбільш популярні ГІС-програми, такі як ArcGIS, QGIS, Schlumberger Petrel, MapInfo та 

інші. Розглядаються їх можливості, особливості використання в геології та переваги для 

різних типів досліджень. Також аналізується перспектива розвитку ГІС-технологій та їх 

роль у майбутніх геологічних дослідженнях. 

 

 


